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 XE "Welcome " \* MERGEFORMAT  Welcome to XC Setup

XConnect is Sutron Corporation's latest data collection, data processing and data storage software. Built on the strong principles of PcBase2, XConnect is compliant with today's 32-bit Windows operating systems and provides new tools and options for the user.

XConnect is a collection of executables designed to provide a complete solution for data collection, data handling, data viewing and data storage.

XC Setup provides system setup and configuration information to all other XConnect applications and clients. XC Setup will automatically start when any XConnect module is started.  It is not necessary to start XC Setup manually.  

Using XC Setup

 XE "Moving around XC Setup " \* MERGEFORMAT 

 XE "Main:Window " \* MERGEFORMAT 

 XE "Main " \* MERGEFORMAT Moving around in XC Setup

The XC Setup application consists of these main areas:

· The Menu Bar provides access to all user-controllable functions within the application.

· The Toolbar provides one-click access to important functions.

· The Status Window provides the user with informational or error messages.

[image: image4.png]=lolx|
e optonstep

SU(BE @

Status [~ &liMessages

SEIAZ004 153622 Ttalines reaa - 1136
DBM42004 153622  Reading - XConnect XCORNECT

‘
INONEIFULL





Figure 1.  XC Setup main window
 XE "ReInitialize " \* MERGEFORMAT 

 XE "Refresh " \* MERGEFORMAT 

 XE "Menu " \* MERGEFORMAT 

 XE "Main:Menu " \* MERGEFORMAT 

 XE "Main " \* MERGEFORMAT 

 XE "Edit Save Setup Interval " \* MERGEFORMAT 

 XE "Clear Status Messages " \* MERGEFORMAT Menu Bar

The Menu Bar provides access to the following menus:

	File
	· Open -- select a setup file for XC Setup to access.

· Save -- tell XC Setup to save the setup file otherwise will auto-save setup hourly.

· Login -- user login for XConnect system.

· Exit -- terminate the application.

	Options
	· ReInitialize -- send an application ReInitialize message to all applications (other XConnect programs and other client programs) connected to XC Setup controlling or using communications ports (XC Mux and XC Rtu).   Applications are instructed to flush their local buffers and reload the latest setup information from XC Setup and Reinitialize the communication ports by releasing the com port and opening it with new port parameters.
· Make INI default -- define the setup file currently in use by XC Setup as the default setup file (ie, the file which XC Setup will open on startup).
· Edit Save Setup Interval -- change the interval that XC Setup will automatically save parameters in memory to disk.  Default is 10 minutes.
· Save INI Backup Copy -- Save all parameters in memory to a backup file.  Filename will be the current INI filename with the date and time appended to the filename.
· Clear Status Messages -- clear the status window.

	Help
	· XC Setup Help -- access this help system and defaults to Index tab.

· XC Setup Contents -- access this help system an defaults to Contents tab.

· About -- get version information for this application.


 XE "Toolbar " \* MERGEFORMAT Toolbar

The toolbar area allows you to quickly access XC Setup functions. 

The following tools are provided:

	[image: image5.bmp]
	Display a file open dialog so you can select an alternate setup file.

	[image: image6.bmp]
	Save setup information to setup file.

	[image: image7.bmp]
	Send an application reinitialize message all XConnect applications instructing them to flush their local buffers and reload the latest setup information from XC Setup. Additionally, those applications that are accessing ports (XCMux, XCRtu) will also release the port and obtain new port information and re-open the port.

	[image: image8.bmp]
	Defines the setup file currently in use by XC Setup as the default setup file (ie, the file which XC Setup will open on startup).

	[image: image9.bmp]
	Open the on-line help (this document).


 XE "Status window " \* MERGEFORMAT 

 XE "Status messages " \* MERGEFORMAT 

 XE "Messages " \* MERGEFORMAT Status Window

The Status Window updates in real-time to keep you apprised of XC Setup messages.  When XC Setup starts, it typically presents the name of the setup file it is accessing followed by a count of the records it has loaded into its local memory.

 XE "Status Bar " \* MERGEFORMAT 

 XE "Hints " \* MERGEFORMAT Status Bar

The Status Bar is divided in two sections.  The left-hand panel displays the user logged in and his/her privileges.  The right-hand panel displays parameter hints.  

If no users are defined, the user logged in will be NONE and the privileges will be FULL.  As soon as a user is defined in XC Desktop, the user and privileges displayed will be NONE and NONE.

 XE "Messages:Status " \* MERGEFORMAT 

 XE "Messages:All " \* MERGEFORMAT 

 XE "Messages " \* MERGEFORMAT 

 XE "All Messages " \* MERGEFORMAT All Messages

By default, XC Setup will only show warnings and errors in the Status window.  If the user wishes to see all data requests and transactions via DDE or COM, click the All Messages check box.

 XE "Starting:XC Setup " \* MERGEFORMAT 

 XE "Starting " \* MERGEFORMAT 

 XE "INI file " \* MERGEFORMAT Starting XC Setup

Once the XConnect installation is complete, you will have a program group containing all the XConnect program icons.  XC Setup can be started one of two ways:  manually or automatically.

To start XC Setup manually

· Go to the Start menu, select Programs - XConnect - XC Setup.
To start XC Setup automatically

· Start any XConnect program (i.e., XC Desktop or XC Mux) and XC Setup will be started automatically. 

After startup, XC Setup reads the INI file and stores all the parameters in its memory.  XC Setup will provide this information to any XConnect applications and XConnect clients requesting setup information.  If any applications send changes to XC Setup, XC Setup will automatically save the parameters in memory to the INI file every 10 miniutes.

 XE "Status window:Clearing " \* MERGEFORMAT 

 XE "Messages:Clearing " \* MERGEFORMAT 

 XE "Messages " \* MERGEFORMAT 

 XE "Clearing messages " \* MERGEFORMAT 

 XE "Clearing:Status window " \* MERGEFORMAT Clearing the Status Window

The purpose of the status window is for XC Setup to display the all data requests via COM or DDE to XC Setup.   To clear the window of existing messages:

1. Click the XC Setup icon on the desktop. The XC Setup application will start minimized.

2. From the Options menu, select Clear Status Messages.
 XE "Reintialize " \* MERGEFORMAT 

 XE "Refresh " \* MERGEFORMAT Reinitialize

Every XConnect application gets the configuration data it needs from the XC Setup program.  But since most of this information is requested at application startup, there needs to be a mechanism for propagating changes that are made to the setup after the applications are already running.  This mechanism is provided via the ReInitialize [image: image10.bmp]function which can be found on the XC Setup toolbar or under the Options menu.

Clicking the ReInitialize [image: image11.bmp]sends message all other XConnect applications instructing them to flush their local buffers and reload the latest setup information from XC Setup.  Those applications that are accessing ports (XC Mux, XC Rtu) will also release the port, obtain new port information and reinitialize the port with the new parameters.

 XE "INI file " \* MERGEFORMAT 

 XE "Backup up " \* MERGEFORMAT Backing up the INI file

All the effort in an XConnect system is in the creation and maintenance of the INI file.  Descriptions of all stations, sensors, poll groups, and data directories are stored in the INI file.  All entries made in XC Desktop are stored by XC Setup in the INI file.  It is good practice to save a backup copy of the INI file in another directory or computer in case of computer failure.  

Restoring your system simply requires you to reinstall XConnect and then copy the INI file to the XConnect directory.

 XE "Opening:projects " \* MERGEFORMAT 

 XE "Opening:INI file " \* MERGEFORMAT 

 XE "Opening " \* MERGEFORMAT 

 XE "INI file:Switching " \* MERGEFORMAT 

 XE "INI file " \* MERGEFORMAT Working with INI Files

The configuration parameters for an XCONNECT data collection system are stored in the system ".INI" file. (Also referred to as the "setup" file.)   The default .INI is the file XC Setup will open automatically on startup.  When XConnect is newly installed, the name of the default setup file is "XCONNECT.INI".

Switching INI Files

There may be times when you want to change to a different INI file.  For example, you might want to experiment with an alternate system configuration.  If this alternate configuration requires a lot of changes in the setup, you will want to make a copy of your default INI file -- let's say you call the new file TEST.INI -- and then manually open this alternate file in XC Setup.  To manually open the file:

1. Click the XC Setup icon on the desktop. The XC Setup application starts minimized.

2. From the File menu, select Open;  or from the toolbar, click [image: image12.bmp].

3. Navigate to the location of your alternate .INI file and select it.

4. Click OK.

Now you can make any changes you want using XC Desktop and XC Setup will store these changes in the alternate setup file (TEST.INI in the example above.)

[image: image13.png]


TIP:  If you want to make to make the newly opened file the default INI file, click the [image: image14.bmp] button on the toolbar.

 XE "Save Setup Interval " \* MERGEFORMAT 

 XE "INI file " \* MERGEFORMAT 

 XE "Edit Save Setup Interval " \* MERGEFORMAT Save Setup Interval

After startup, XC Setup reads the INI file and stores all the parameters in its memory.  XC Setup will provide this information to any XConnect applications and XConnect clients requesting setup information.  If any applications send changes to XC Setup, XC Setup will automatically save the parameters in memory to the INI file every 10 miniutes.  The user can change the default value of 10 minutes:

1. Click the XC Setup icon on the desktop. The XC Setup application will start minimized.

2. From the Options menu, select Edit Save Setup Interval.  The Save Setup Interval dialog box will appear. 
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Figure 2.  Change Save Interval
3. Enter desired save interval and click OK.

4. XC Setup will now automatically save the parameters stored in memory on the new interval.

Save Backup INI file

The Save Backup INI file menu option will save INI settings in memory to an alternate INI file for backup purposes.  The new filename will have the date and time appended to the original INI filename.
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Figure 3.  New INI back filename
Troubleshooting

 XE "Troubleshooting:tips " \* MERGEFORMAT 

 XE "Troubleshooting " \* MERGEFORMAT 

 XE "tips:Troubleshooting " \* MERGEFORMAT 

 XE "tips " \* MERGEFORMAT Troubleshooting tips

All XConnect applications interact closely with XC Setup all during data collection, data processing and data storage.  If XC Setup is not functioning properly, it will affect all of XConnect.  If you suspect this problem, select the All Messages check box to see what, if any activity.  Proceed to the Error Messages topic to troubleshoot the specific errors displayed in XC Setup.

 XE "Troubleshooting " \* MERGEFORMAT 

 XE "steps:Troubleshooting " \* MERGEFORMAT 

 XE "steps " \* MERGEFORMAT 

 XE "Invalid user/password " \* MERGEFORMAT 

 XE "Errors " \* MERGEFORMAT 

 XE "Error saving " \* MERGEFORMAT 

 XE "Error adding key " \* MERGEFORMAT 

 XE "DDE Error " \* MERGEFORMAT 

 XE "Corrupt keyword/value " \* MERGEFORMAT Error Messages

Potential error messages generated by XC Setup are:
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Error 1:  User does not have correct privileges to perform action [image: image18.png]



Troubleshooting steps:

Reasons for error:

· User name is not configured for read/write privilege.

Return to XC Desktop to configure user privileges.
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Error 2:  Invalid user/password settings [image: image20.png]



Troubleshooting steps:

Ensure that:

· User name and password are entered correctly.

· Caps lock key is on (User name and passwords are case-sensitive).

Error 181:  Invalid topic for DDE Request  

Troubleshooting steps:

Ensure that:

· A client sending a DDE request has the correct DDE topic configured for XC Setup.  The only valid DDE topic for XC Setup is Data.

Error 182:  Error in DDE Request received. Invalid item -  

Troubleshooting steps:

Ensure that:

· A client sending a DDE request has the correct DDE item configured for XC Setup.  Refer to the XConnect Technical reference for valid DDE items.

Error 300:  Error adding key -  

Troubleshooting steps:

Potential reasons for error:

· Corrupt keyword/value in INI file.

Keyword will be ignored.  Re-select/configure parameter in XC Desktop.

· Memory problems resulting from XConnect or another application.

Close all applications and re-start XConnect or reboot computer.

Troubleshooting steps:

Ensure that:

· You have enough space on your hard drive.

· There is not an existing document that is marked read-only.

Error 301:  Error saving setup 

Troubleshooting steps:

Potential reasons for error:

· File is already open.

Ensure the INI file is not opened by another application such as Notepad.

· Insufficient disk space available.

Check the disk space available on the disk drive the XConnect is installed on.  Remove files from the Recycle Bin or Temp directory.

Error 302:  Unable to make current INI file default 

Troubleshooting steps:

Ensure that:

· User logged into Windows® has the correct privileges to change the registry.  Check with your Network Administrator.

Error 303:  COM Data request for Item link failed - 

Troubleshooting steps:

Potential reasons for error:

· Insufficient memory to add current link requests to current list.

Close all applications and re-start XConnect or reboot computer.

Error 304:  COM Client not responding to Refresh...

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the current clients display a status message indicating the receipt of the Refresh message.

Error 305:  COM Client not responding to ReInitialize... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the ReInitialize command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the current clients display a status message indicating the receipt of the ReInitialize message.

Error 306:  COM Client not responding XC Setup Shutdown... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Shutdown command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the current clients shutdown upon receipt of this message.

Error 307:  COM Client not responding to Reset XC Decode Parms... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh XC Decode parameters command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the XC Desktop receives this message.  A dialog box will open in XC Desktop.  If XC Decode parameters are not refreshed, click the Refresh ([image: image21.bmp]) icon.

Error 308:  COM Client not responding to Reset XC Mux Parms... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh XC Mux parameters command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the XC Desktop receives this message.  A dialog box will open in XC Desktop.  If XC Decode parameters are not refreshed, click the Refresh ([image: image22.bmp]) icon.

Error 309:  COM Client not responding to Reset XC Rtu Parms... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh XC Rtu parameters command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the XC Desktop receives this message.  A dialog box will open in XC Desktop.  If XC Decode parameters are not refreshed, click the Refresh ([image: image23.bmp]) icon.

Error 310:  COM Client not responding to Reset XC Daps Parms... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh XC Daps parameters command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the XC Desktop receives this message.  A dialog box will open in XC Desktop.  If XC Decode parameters are not refreshed, click the Refresh ([image: image24.bmp]) icon.

Error 311:  COM Client not responding to Reset Sensor Decode Parms... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Refresh Sensor Decode parameters command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the XC Desktop receives this message.  A dialog box will open in XC Desktop.  If XC Decode parameters are not refreshed, click the Refresh ([image: image25.bmp]) icon.

Error 312:  COM Client not responding to item change event for 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the Item change event command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Error 313:  COM Client not responding to user login change... 

Troubleshooting steps:

Potential reasons for error:

· A client "connected" to XC Setup did not receive the User login change command.  

A client should properly "disconnect" from XC Setup prior to closing.  If not, XC Setup will still think it is still "connected".  A client may have been terminated abruptly by Windows before "disconnecting".  In this case, the error can be ignored.

Make sure the current clients display the correct User and privilege in the left-hand panel of the status bar of each application.

Error 180:  DDE Error -  

Troubleshooting steps:

Potential reasons for error:

· Unknown DDE error.  Restart client program and XC Setup.  

 

Glossary

#

8200: Line of Sutron Data Recorder and Transmitters including the 8200, 8200A, and 8210.

9000: An RTU manufactured by Sutron. Differentiated from the 8200 line by its modular BUS design, expandability, and complete programmability. Includes a powerful SCADA and control language called SDL.

A

Alarm Data: Sensor data resulting from a alarm message from an RTU. Contains just the most recent measured values for selected sensors.

ALERT: Automated Local Evaluation in Real Time. ALERT transmitters are one-way LOS radio systems which transmit short (4 byte) messages on exception (usually at 300 baud). ALERT messages have minimal error detection and no means of error correction. RTU Server supports the decoding of these messages.

B

BERT: Bit Error Rate Test. A communications test designed to detect bit errors in a serial data stream. SSP supports a BERT test which can be performed from Operator Desktop or from an RTU.

C

Current Data: Sensor data resulting from a current data poll of an RTU. Same format as Alarm Data, and contains just the most recent measured values for selected sensors.

D

DAPS: A computer system at Wallops Island, VA operated by NESDIS which processes environmental data from the GOES satellite and makes it available to the user community via dial-up modem lines. DAPS supplies the GOES data in a specific format (also referred to as the NESDIS format) which is compatible with Sutron software.

DCP: Data Collection Platform. A remote data acquisition device which primarily transmits its data through the GOES Satellite.

DDE: Dynamic Data Exchange. An industry standard for transferring data between applications. The primary means PCBASE2 programs share data between applications. A simple messaging protocol which supports real-time data transfer through its support of hot-links.

DEMOD: Demodulator. The part of a receive site which monitors a preset channel (or frequency) and converts the encoded analog data stream in to a digital message.

DOMSAT: Domestic Satellite. A low earth orbit satellite used to rebroadcast GOES messages, allowing reception using a small dish.

G

GOES Radio: A radio transmitter which can send messages to the Geostationary Operational Environmental Satellite. Many other satellites behave similar to the U.S. launched GOES satellite. Often when you see settings for GOES in PCBASE2 they will also apply to other satellites including: DOMSAT, ARGOS, METEOSAT, INSAT, SCD-1, GMS, etc.

H

Hard disk capacity: The amount of memory available on a PC fixed media storage device, usually measured in Mega (million) bytes (Mb) of memory.

HTML: Hypertext Markup Language. A set of tags used to mark the structural elements of text files. HTML files include tags that create hyperlinks to other documents on the Internet.

HTTP: Hypertext Transfer Protocol. The communications protocol on which the Web is based. HTTP sets rules for how information is passed between the server and the browser software.

I

Icon: A picture or symbol that represents an object, task, command, or choice users can select by pointing and clicking with a mouse.

Index: A list of keywords the user may view to find topics within a Help system.

M

Memory: The part of a computer that stores information or instructions. Memory can be RAM (Random Access Memory) or ROM (Read Only Memory), and is usually measured in Kilobytes (thousand) or Megabytes (million) bytes of memory.

P

Pane: A frame used to display program components.

U

URL: Uniform Resource Locator. An Internet address, as well as a standard method of naming files on the Web. A URL begins with a protocol name (such as http), followed by a colon and two forward slashes(//). Next comes the name of the internet server that the file is stored on, followed by directories that hold the file, separated by forward slashes(/). The filename comes last, as shown in the following example: http://www.mycompany.com/whatsnew.htm

W

Web browser: Commonly called a browser. A software application for displaying HTML pages on the World Wide Web. Common browser applications include Microsoft Internet Explorer and Netscape Navigator.

WWW: World Wide Web. The graphical Internet hypertext service that uses the HTTP protocol to retrieve Web pages and other resources from Web servers.
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